
Introduction 

These tutorials will provide you with a practical introduction to using the neural simu-
lation software and give you an insight into the principles of connectionist modeling. 
They are intended to be complementary to the detailed operation manual. Detailed 
instructions on which buttons to press are not included here in most cases. 

Links 

● iqr page  : http://iqr.sourceforge.net
● repository of iqr packages     (http://sourceforge.net/project/showfiles.php?

group_id=190531)

Bugs and features on sourceforge 

● Submit bug report (http://sourceforge.net/tracker/?  
group_id=190531&atid=933732)

● Submit feature request (http://sourceforge.net/tracker/?  
group_id=190531&atid=933735)

Code on sourceforge 

● browse SVN repository   (  http://sourceforge.net/svn/?group_id=190531  )  
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Tutorial 1: Creating a simulation

Aims 

● Understand and assimilate the basic principles and concepts of iqr:

○ System

○ Process

○ Group & its properties (neuron type, topology)

○ Random Spike Neuron & properties (probability, amplitude)

○ Cycles Per Second (CPS)

○ Space plot, Time plot & Sync plots

● Create a simulation containing a group of cells that spike randomly

● Run the simulation and see the output using Space Plots and Time Plots.

● Build your first iqr system

Advices

● Go slowly.

● It is important that you understand what you are doing. Try to assimilate 
the concepts  (group of neurons, process, synapses, time plot, CPS, arboriza-
tion, etc) when their appear. Otherwise you will be lost for future exercises.

● Keep a copy of the “iqr User Manual” handy, and make sure you read the 
corresponding section in the manual  when new concepts are introduced. 
Checking each concept there will save a lot of time.

● It is also important that after the practicum you create back-ups of every 
file. 

● Don't forget to save your simulation after you make modifications: 

○ File →  Save As and give it a name like Tutorial 1.



Introduction

iqr is is a tool for creating and running simulations of large-scale neural networks. 
The key features are: graphical interface for designing neuronal models, graphical 
on-line control of the simulation, change of model parameters at run-time, on-line 
visualization and analysis of data, the possibility to connect neural models to real 
world devices such as cameras, mobile robots, etc; predefined interfaces to robots, 
cameras, and other hardware, open architecture for writing own neuron, synapse 
types, and interfaces to hardware.

Models in iqr are organized in different levels: the top level is the system and con-
tains an arbitrary number of processes and connections. Processes in turn consist 
of an arbitrary number of groups.

 
At the process level it can be defined if a process is a standard process or if it con-
nects the system to external hardware. Each process works as a logical unit in which 
groups of neurons can be defined. Such a logical unit is responsible for a specific 
task at your system.

A group is defined as a specific aggregation of neurons of identical type, specific 
in terms of the topology (i.e. spatial arrangement ) of the neurons in the group being 
a property of the group.

Connections are used to feed information from group to group. A connection is de-
fined as an aggregation of synapses of identical type, plus the definition of the 
arrangement of the synapses.

Fig. 1: IQR basic conceptual schemes



Building the System 

● First of all, you have to create a  process using the  process button in the 
button bar. This will happen at the system level (New System in Fig. 1). To 
do this, press the process ('P') button and then move the mouse to the “dia-
gram editing panel” and press left button again. A grey square 'New Process 
1' should have been created (Fig. 3). 

● Once the process is  created, you edit  its  name by editing its  properties. 
Change  the  name  to  “Tut  1  Process”.  A  new  tab appears  when  the 
process is created. If you click on it, it shows the  contents of that process 
(i.e.: groups and connections) as shown in Fig. 4. 

● Click the “Tut 1 Process” tab. Start adding groups that will performance in-
side the process by clicking on the group icon. 

● Now edit the properties of the new group and set:

○  Set 'Group Name' as 'RandomSpikeGroup'.

○ Set the type of the Topology as 'TopologyRect' and click there 'edit'. 
Make it 10 cells wide and 10 cells high (it will be used again in later exer-
cises). Note: Topology refers to the packing of the cells within the group. 
In this case TopologyRect means that every field in the lattice is occu-
pied by one neuron. 

Fig. 2: General view of the IQR Graphical Interface



○ Set the 'Neuron type', the type of the neuron, to RandomSpike. Then 
press edit and give it a spiking 'Probability'   of 0.42   and set the '  Spike   
Amplitude'   to 1.0  . 

Fig. 4: Group creation inside a process and group properties

Fig. 3: Process creation and process properties



Exercise

Step 1. Set cycles per second (CPS) to 25:

• Go to File → System Properties. Set 'Cycles Per Second' (CPS) to 25. Press 'tab' 
key and then OK. (CHECK: open again the same menu to make sure CPS is set 
as you wanted. ).

• Check also 'Sync Plots' to make sure every event is represented in real-time in 
the space and time plots.

 Step 2. Press the Play button to start the simulation.

1. Press right button over the neuron group, and bring up the space plot to watch 
the cells spiking - don't forget to select the 'live data' check box and choose the 
cell  state  variable that  you  want  to  watch  (activity means  only  when the  cell 
spikes). In brief, the space plot  shows the state of each cell in a group in the plot 
area.

Q1. What do you see?  Which is state is being represented? Is it similar to the 
bottom diagram in Fig. 5?

Q2. What does each small square represent?

Q3. Can you see activity of two different times in space plot or it is just instan-
taneous information?

2. Press right button again over the neuron group (without quitting the space plot) 
and bring up a time Plot as well. Check again 'live data' and the same cell state 
variable as the space Plot. In brief, time plot shows the states of neurons against 
time.

Q1. Explain what you see.

Q2. Are you watching in the time plot the activity of one neuron, the average 
of the whole group of the total activity of the whole group?

3. Try to play with the properties of the neuron group (such as Probability, Spike Am-
plitude and Size of the Group). STOP the simulation before changing those parame-
ters.

Q1. What does that 'Probability' means? 

Q2. What happens if you set probability to '1'?

Q3. What happens in the space plot if you change spike amplitude? And in the 
time plot?

Q4. What about the size of the group? Describe the effects in both type of dia-
grams.

Q5. Can you perceive any substantial difference in the space plot?

4. Now, drag only 1 cell from the space plot in the time plot. 

Q1. What do you see? 



Q2. What about dragging a group of 4 cells for example?

Q3. Does it give you the sum of the individual activities of the average of the 
selected group? Play with different combination of cells to discover it.

5. What does the "CPS:" in the bottom-left corner of the window mean? Change the 
values in  File →  System Properties and check how the simulation speed changes 
(e.g.: CPS = 1; CPS = 2; CPS = 10. Take care because CPS=0 gives you the maxi-
mum speed the machine can give and it might freeze the system). 

Q1. What is a CYCLE in IQR? 

Q2. Can you see different cycles at the same time in a space Plot?

Q3. Can you see different cycles at the same time in a time Plot?

Fig. 5: Time and space plots



Tutorial 2: Cell Types, Synapses & Run-time State Manipulation

Aims 

● Understand and assimilate the basic principles and concepts of iqr:

○ Neuron groups: Random spike, Linear threshold, Sigmoid, Integrate and 
Fire.

○ Neuron properties: threshold, excitatory gain, membrane persistence. 

● Link multiple cell groups of different types using connections:

○ Synapses & connection properties (synapse type: 'uniform fixed weight', 
pattern map).

○ Connection plot

Introduction

In iqr models, the main difference between types of neurons (for mathematical for-
malization, please refer to the iqr manual)  is the transfer-function between the 
inputs and the outputs, and how the inputs are integrated in the membrane poten-
tial.

– Linear threshold (LT): it sums up all the inputs with a certain gain (excitato-
ry gain for excitatory connections or inhibitory gain for inhibitory connections). 
Then, there is a threshold.  Once the integration of the inputs (what consti-
tutes the  membrane potential)  is over the threshold, the output follows    lin  -  
early   the input, otherwise output is zero  . The integration of the inputs can be 
also manipulated by a parameter called persistence. This parameter deter-
mines how much of the Membrane Potential in time t still remains in time t+1. 
This allows a neuron to integrate signals over time, not only instantaneously, 
therefore providing some sort of memory.

– Integrate and Fire (IF): it works very similar to LT neuron, but there is a big 
difference when the membrane potential reaches the threshold: the IF neuron 
spikes with maximum amplitude (usually is 1), independently of the input, and 
then resets the membrane potential to 0. Again, it is possible to use the mem-
brane persistence to allow faster spiking activity.

– Sigmoid (S): In this case the transfer function is a sigmoid and there is not 
possible threshold to set. Persistence does matter again.

Building the System 

Open the simulation you created in Tutorial 1. Then create a copy: to do this is use 
File → Save System As option in the main menu. Give it a name like 'Tutorial 2'. 
Change also the name of the process to something like 'Tut 2 process'.

Change the spiking probability of your original "RandomSpike" cell group slightly, 
e.g. to 0.1 (the exact number does not matter). 

Create  three  more neuron groups  of  1  single  neuron.  The types for  these new 
groups must be: a linear threshold, an integrate and fire and a Sigmoid. 



Now create excitatory connections from the RandomSpike cell  group to each of 
your new cell groups, using the red connection creation button that appears in Fig.
6. The result of the connection scheme is in Fig. 7.

Every red line represents a connection. Click right button over one of them and 
choose properties:

● Change the  synapse type (it appears at the bottom of the  Fig. 7) for each 
connection to Uniform fixed weight.  This means that the weight does not 
change during the simulation and it will be fixed to certain value (if it is set to 
'1', it means there is no gain or loose of potential during the connection).

● Set the pattern map to “all” instead of “center”. 

● Once you have changed that, press Apply and Accept. If apply is not pressed 
changes will not be stored.

● Click right button in the connection and select connection plot. It gives you 
a the idea of how each neuron is connected to the other one. This is a useful 
tool that you may want to use every time you create a new connection to 
check if the mapping you want is correctly set.

Fig. 6: Connection Icons



● Play with it. Click in both 'squares' that represent the neuron groups. Arrow 
shows the 'source' (origin of the arrow), and the 'target' (arrow end) of the 
connection. This means that one spike in a neuron (or group of neurons) of 
the source is propagated through the connection to another neuron (or group 
of  neurons)  of  the target,  making them to  spike (according to  the neuron 
transfer function, threshold, etc). Best thing is to create bigger groups of neu-
rons and define different patterns to check this tool.

Exercise

1. Bring up space and t  ime plots   for each cell group and start the simulation. Ev-
ery one has the name of the group, so check if you can identify each one. 
What do you see? 

A.  Connection  between  Random  Spike  (RS)  and  Linear  Threshold  (LT) 
groups.

Q1. Space plot: is the cell spiking continuously?

Q2. Time plot: is it following the source? Why? (Note: think of the pat-
tern map and also in the definition of LT neuron.)

B. Connection between RS and Integrate and Fire (IF) groups.

Q3. Space plot: why is all the time spiking?

Fig. 7: Excitatory connection scheme and Connection prop-
erties dialog



Q4. Time plot: is it following the source? Why?

C. Connection between RS and Sigmoid.

Q5. Space plot: why is all the time spiking?

Q6. Time plot: is it following the source? Why?

2. Inside the properties of the neuron groups, play with the excitatory gain, 
threshold and membrane persistence (check the time and space plots the 
option 'vm' that is the membrane potential:

Q1. Explain what these parameters do:

Q2. Explain what is the membrane potential and its relation with the in-
put and the threshold.

Q3. Explain also the role of persistence in the input, the membrane po-
tential and the output.

3. Write down the parameters you have used. 

Group name LinTh IntFire Sigmoid

Size (cells) 

Cell Type Linear threshold Integrate & Fire Sigmoid

Excitatory gain 

Probability --------------

Membrane persis-
tence 

Threshold --------------

Membrane potential 
reset 

Spike amplitude 

Sigmoid midpoint -------------- --------------

Sigmoid slope -------------- --------------

4.  Stop  the  simulation  and  change  the  PatternMapped to  'center'.  Check 
again the connection plot. 

Q1. Run the simulation watching the plots. What was the effect and why?

Q2. Play with the size of the neuron groups. One detail to take into ac-
count is whether the different sizes are even or odd. Play with this and 
use the connection plot and change the pattern maps between 'center' 
and 'all' to see what happens.

Q3. Try to explain what the difference is. Take a look to the manual if 
you do not know what is going on. Write down a brief explanation.





Tutorial 3: Changing Synapses & Logging Data 

Aims 

● Understand and assimilate the basic principles and concepts of iqr:

○ Connection type: inhibitory

○ Neuron properties

○ Arborization

● Try out different connection types. 

● Manipulate the states of cell groups at run-time and see how the cells are af-
fected. 

● Draw some patterns using the state manipulation panel and play them. Save 
the patterns for future uses.

● Record simulation data for later analysis using the data sampler. 

Introduction

1. Arborization

Arborization is a way of having more complex connection between neuron groups. 
Basically it defines how given a specific connection between two neurons (defined 
with the pattern property), this is extended to the adjacent neurons. There are two 
options: receptive field and projective field (Fig. 8). 

– Receptive Field: a single connection can connect several pre-synaptic neurons 
to one pot-synaptic neuron.

– Projective field: one pre-synaptic neuron projects information over a group of 
post-synaptic neurons. 

You may want to use the connection plot when defining arborization to make sure ev-
ery connection is as you specify.

Hence a connection in iqr can comprise several axons, synapses and dendrites from 
a biological point of view. In iqr terms, this will be defined as a matrix of connectivity. 



PLEASE, check the manual for further and deeper explanation and diagrams. 
(Sec.:2.13.2)

2. Inhibitory connection

In previous chapters we played only with excitatory connections. In this case we will 
play with the inhibitory type. In this case, the increase of the activity of the pre-
synaptic neuron makes a reduction of the membrane potential of the post-synaptic 
neuron. So if a post-synaptic neuron has two inputs, one inhibitory and one excitato-
ry, the output of the activity of this neuron will be reduced thanks to its inhibitory in-
put. You can also check these types of connections in the connection plot. 

3. State Manipulation Panel

The state manipulation panel is a tool to manipulate directly the activity of a specific 
neuron group. The interface is shown in Fig. 9. 

PLEASE, check the manual for a complete guide of use.(Sec.:2.16)

4. Data Sampler

Data sampler (Fig. 10) allows you to save data during a simulation. You can save in a 
text file different parameters of activity (input, output, membrane potential) from the 
neuron groups you want. This is to log the simulations and to have data in a text for-
mat that can be later read and analyzed in other programs like Excel, SPSS, Octave, 
Matlab, etc. It works very easily just by dragging from the space plots the neurons 
you want to log into the data sampler interface and selecting the appropriate options. 

PLEASE, check the manual for a complete guide of use.(Sec.:2.15.6)

Fig. 8: Receptive field and Projective field in the context or arboriza-
tion



Building the System 

● Create a copy of the simulation you used in Tutorial 2  and call it Tutorial 3 
and start with it. Rename also the process.

● Delete the Sigmoid neuron group. 

● Set the Linear Threshold group properties:

◦ Threshold = 0;

◦ Membrane Persistence = 0;

● Change the size of the Linear Threshold group using the Topology option to 30 
by 30 neurons (if the computer goes slow, reduce it to 10x10 for example).

● Change the size of the Random Spike group to 1 single neuron. Save the sim-
ulation when you have finished. 

Fig. 9: State manipulation panel



Exercise

Start the simulation, and bring up the Space Plot and observe the activity in the Lin-
ear Threshold group. 

1. We want to modify the connection parameters to generate a rectangular, cir-
cular and elliptic  activation of the post-synaptic neuron group. For that modi-
fy the arborization properties (Projective Field) and the attenuation. In the 
circular and elliptic case, when using attenuation, you should get space plots 
similar to Fig. 11. It may be a good idea to check the connection plot to make 
sure the connection scheme is well set.  

Q1. Write values in the table

2. Now,  repeat  the  exercise  trying  to  get  a  Gaussian  activation of  the  post-
synaptic neuron group. Again, modify the arborization properties (Projective 
Field) of the synapse and the attenuation. You should get a space plot simi-

Fig. 10: Data sampler

Fig. 11: Circular and elliptic activation



lar to Fig. 12. The 3-d view of this activation should be similar to Fig. 13. 

Q1. Write values in the table

Connection Rectangular Circular Elliptic Gaussian 

Pattern

Arborization 

Attenuation 

Synapse 

3. Stop the simulation. Create an inhibitory connection from the Integrate and 
Fire group to the Linear Threshold one using the blue arrow icon, and set the 
synapse type to "Uniform fixed weight" (this means that every connection be-
tween the pre-synaptic neuron group and the post-synaptic neuron has the 
same weight/gain).  Run the simulation again.

Q1.  What do you see? 

Q2.  Which  is  the  difference  between  an  excitatory  and  inhibitory 
synapse? Check the membrane potential state using the time plot to 
verify what is happening.

Fig. 13: Example in 3d of a gaussian distribution

Fig. 12: Gaussian activation



Now we want the Linear Threshold group to have a receptive field that re-
spond to surrounding excitation. This means that every post-synaptic neu-
ron must integrate the activity of more than one neuron of the pre-synaptic 
group. Change the Linear Threshold group dimensions to 1 neuron and the 
RandomSpike group to 10 by 10. 

4. Change also the connection settings to achieve the correct receptive field. 

Q1. Which are the new parameters?

Connection Rectangular Circular Gaussian 

Pattern 

Arborization 

Attenuation 

Synapse 

5. Use the state manipulation panel on the RandomSpike group to generate a 
circular, rectangular and gaussian like activation. Bring up the Time Plot of the 
Linear Threshold group. 

Q1.  When is it responding maximally?

6. Open the Data Sampler under the "Data" menu. Save some data from the cell 
groups  of  your  choice.  Open  the  data  file  in  OpenOffice  or  Excel.
 

Q1. What you see in the file? 
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